Contents

1. Preparing content for your app ................................................................. 6
   1.1. Preparing text ......................................................................................... 6
   1.2. Preparing images .................................................................................. 8
   1.3. Preparing audio ..................................................................................... 9

2. How to build your first app ..................................................................... 9

3. App Creation Basics .............................................................................. 12
   3.1. How should I choose the app package name? ...................................... 12
   3.2. Where do the default book names and abbreviations come from? ...... 13
   3.3. Do I have to create a new keystore for each app, or can I reuse the same
       keystore for several of my apps? ............................................................... 14
   3.4. How can I include pictures in my apps? ................................................. 14
   3.5. How can I add a horizontal line to separate certain paragraphs in text?  15
   3.6. I don’t like the name “Scripture App”. Have you thought of calling the app
       something else? ....................................................................................... 15
   3.7. Can I build apps when I do not have internet access? ......................... 15
   3.8. How do the glossary entry popups work? ............................................ 16
   3.9. Can I build an app from the command line? ........................................ 17

4. Fonts ........................................................................................................ 19
   4.1. What is Grandroid? ................................................................................ 19
   4.2. When do I need to include the Grandroid libraries? .............................. 19
   4.3. What is Crosswalk? ............................................................................. 20

5. Audio ....................................................................................................... 21
   5.1. How can I associate audio files with the text? ..................................... 21
   5.2. How do I create the audio timing files for audio-text synchronization?  22
   5.3. How do I distribute the audio files with the app? ................................. 22
   5.4. How are the timing files distributed for the app? ................................. 26
   5.5. How can I use audio clips in the app? .................................................. 26

6. Video ....................................................................................................... 27
   6.1. How do I include videos in the app? ..................................................... 27
   6.2. How do I specify where the videos will be displayed within the app? .... 28

7. About Page ............................................................................................. 29
15.7. What audio timing labels are used? ................................................................. 54
15.8. How can I add background music when the audio is playing? ....................... 54
15.9. Where can I get sample story book text and pictures? ................................ 55
15.10. How can I record the audio files? ................................................................. 55

16. Song Books ........................................................................................................ 55
16.2. What do song books in Word documents look like? ....................................... 56
16.3. What do song books in SFM format text files look like? ............................... 59
16.4. How can we associate audio with each song? .............................................. 61

17. Sharing Apps .................................................................................................... 61

18. Deep Linking .................................................................................................... 62
18.1. Setting up Deep Linking .................................................................................. 62
18.2. Creating Deep Links ...................................................................................... 63
18.3. Deferred Deep Linking .................................................................................... 65

19. Analytics .......................................................................................................... 66
19.1. Firebase Analytics ......................................................................................... 67
19.2. Amplitude Analytics ..................................................................................... 68
19.3. Amazon Mobile Analytics ............................................................................. 68
19.4. Google Analytics .......................................................................................... 69
19.5. FCBH Digest Analytics .................................................................................. 69
19.6. S3 Digest Analytics ...................................................................................... 70
19.7. Data Payload for FCBH and S3 Digest Analytics .......................................... 71

20. Registration Screen ......................................................................................... 73
20.1. Setting up the Registration Screen in Scripture App Builder ....................... 73
20.2. Setting up the database in the Google Firebase console ............................. 74

21. EPUB ............................................................................................................. 76

22. Publishing and Distribution ............................................................................ 78
1. Preparing content for your app

Before you build an app with Scripture App Builder (SAB), you need to get your content (text, images and audio) into formats that SAB can handle.

1.1. Preparing text

The text format you need depends on the type of app content you have.

- **Books of the Bible:**
  The Scripture text needs to be in one of the following formats:
  - Paratext files (.usfm, .sfm, .ptx, etc.)
  - USX files (.usx)
  - Digital Bible Library Text Release Bundles (.zip)

- **Other types of app content such as commentaries, picture story books, song books and Bible studies:**
  The text needs to be in one of the following formats:
  - Word documents (.docx)
  - SFM text files (.sfm)
  - HTML files (.html)
  - Bloom books (.bloomd)

Here are some more details about each of these formats:

1. Paratext files for Bible books

SAB can import text from Paratext USFM (Unified Standard Format Marker) files. These are the files used in Paratext projects – one per book of the Bible.

```plaintext
\c 5
\s Kilɛ Kafila yɛrɛ lemu l’a pye faabobɔŋɔ ki ɲuŋɔ ni ge
\p
\v 1 Ayiwa, ba Yesu ya sipyiire ti ɲa wɛ, na dugi tiin faabobɔŋɔ ki ɲuŋɔ ni. A wu wo kalaapiire t’i fulo wu na.
\v 2 A wu wɔ kon na pu kalaa na:
\s Piike p’i ne duba nagoo pu wɛ?
\r (Luka 6:20-23)
\q1
\v 3 \p’i’a li ce na funmo fee pee ne
\q2 Kilɛ shizhaa na ge,
\q2 pee ne duba nagoo,
\q1 bani pee wuuro ti ne
\q2 fugba saanra te.
```

In USFM files, the chapters, section headings and paragraphs are marked by standard format markers such as `\c`, `\s` and `\p`. For more details, please see [http://paratext.org/about/usfm](http://paratext.org/about/usfm).
It is recommended that you run the Paratext Basic Checks to ensure the text is as clean as possible for publishing. Select **Checking ➤ Run Basic Checks...** from the Paratext main menu.

Critical checks:

- **Chapter/Verse Numbers**: Checks for duplicate or invalid chapter or verse numbers. Checks that all chapters and verses defined in the versification for the project are present.
- **Markers**: Checks you are using valid USFM markers and they are not in unexpected places.
- **References**: Checks that Scripture references, e.g. “Mat 6:1-5”, follow exact abbreviations and syntax. If not, they will not work as links in the app.

Important checks:

- All of the remaining basic checks: Characters, Punctuation, Capitalization, Repeated Words, Unmatched Pairs of Punctuation, Quotations, Numbers.
- **Spelling**: In Paratext, select **Checking ➤ Spell Check Current Book...**

2. **Other SFM text files**

SAB can import text from SFM files which contain content other than Bible books, such as commentaries, Bible studies, stories or songs. Like Paratext USFM files, the chapters, section headings and paragraphs need to be marked by standard format markers such as \c, \s and \p.

The first marker in the file must be \id XYZ, where XYZ is a code you choose. Do not choose a code already reserved for a Scripture book, e.g. GEN.

SFM book files must be **plain text files**. If you have Unicode characters, the text files should use UTF-8 encoding.

To create a text file in Windows, use a text editor such as Notepad.

To create a text file on a Mac, use TextEdit, remembering to choose Plain text files in the preferences because otherwise the default file type is RTF (which contains a lot of additional formatting codes).

For more details about how to define picture story books and song books using SFM text files, please see sections 13 and 14.

3. **Word documents (.docx)**

SAB can import text and images from Microsoft Word (.docx) documents.

When Word documents are displayed in the app, basic formatting will be preserved such as character styles (bold, italic, underline), numbered lists, bullet points, hyperlinks, footnotes and simple tables.
To define separate chapters or pages, insert page breaks using CTRL+Enter.

For more details about how to define picture story books and song books using Word documents, please see sections 13 and 14.

4. Digital Bible Library Text Release Bundles
   SAB can import text from Digital Bible Library (DBL) text release bundles. These are zip files containing USX files for each book as well as other configuration information.

   For more information about the DBL, see: http://www.thedigitalbiblelibrary.org.

5. HTML files (.html)
   SAB can display HTML files and make use of associated stylesheets (CSS) and images. Audio-text synchronization is not supported yet with this format.

6. Bloom books (.bloomd)
   SAB can display Bloom books. There are two ways in which it can do this:
   
   - By using an embedded Bloom Player, as used in the Bloom Reader app, or
   - By converting the book into a Picture Story Book.

   For more information about Bloom, please see: https://bloomlibrary.org

1.2. Preparing images
Images are imported from Word documents or need to be specified separately if you use SFM format. They should be in JPEG or PNG format.

Keep the image size small enough so that they display well on a small screen and will not make the app size too large. If your pictures are in a Word document, you can use the Compress Pictures tool in Word. Otherwise, SAB will allow you to resize the images after you have added them to the app project.
1.3. Preparing audio

If you want to include audio files in your app, these need to be in MP3 or 3GP audio format. Normally this should be one audio file per page or chapter. You can also include audio clips which are short audio files that are played when the user taps on a word, phrase or image.

If you have a picture story book, you can have a single audio file for the whole book or one audio file per page.

Keep the audio files at a size where the quality is good enough for a phone and where the file size is not too large.

2. How to build your first app

To build your first app with Scripture App Builder:

1. Launch Scripture App Builder from its icon on the desktop.


3. On the first page of the wizard, specify:
   - the App Name, such as “Dogon Bible”, “Livre de Luc”, “Supyiré NT”, etc. This is the main title of your app and will be seen by the user. Do not include underscores or hard to understand abbreviations.

   Click Next to move to the next page.

4. On the second page of the wizard, specify:
   - the Package Name, a dot-separated string which uniquely identifies your app. For testing, try something like:
     
     com.example.myapp1
     com.example.myapp2, etc.

     (More details about choosing a good package name can be found in section 3.1 How should I choose the package name?)

   Click Next to move to the next page.

5. On the page of the wizard titled Books, click Add Books... and select the books you want to see in the app. These can be USFM (Paratext) files, USX files, Digital Bible Library text release bundles, Word documents (docx) or a zipped file of USFM or USX files.

   Click Next to move to the next page.
6. If you have selected Scripture books, the next page will be titled **Book Order**. Choose the book ordering according to the church tradition of the target users.

   Click **Next** to move to the next page.

7. On the page of the wizard titled **Fonts**, choose the font. You can either select from the given list of fonts or specify a different TrueType font file.

   Click **Next** to move to the next page.

8. On the page of the wizard titled **Grandroid**, choose whether or not to enable Grandroid font rendering.

   In general, you will need Grandroid if you have a non-Roman script (e.g. Arabic, Thai, Hindi, etc.), or if you use a Roman script with combining diacritics. For more details, please refer to section 4 of this manual.

   Click **Next** to move to the next page.

9. On the page of the wizard titled **Color Scheme**, choose the color scheme for the app. The color you choose is the one that will be used for the main app bar. Individual colors for text, titles, links, backgrounds, etc. can be customised later.

   Click **Next** to move to the next page.

10. On the page of the wizard titled **Default Interface Language**, choose the language you want users to see when they first enter the app. This can be the current system language.

    Click **Next** to move to the next page.

11. On the page of the wizard titled **Interface Languages**, choose the app interface languages that the user can choose between.

    Click **Next** to move to the next page.

12. On the page of the wizard titled **Features**, choose the book selector type and numeral system.

    Click **Next** to move to the next page.

13. On the page of the wizard titled **Icon**, choose the application launcher icon. You can select one of the images in the table or if you have your own PNG image files for the icon, click **Browse** and select them.

    Click **Next** to move to the next page.
14. On the pages of the wizard titled **Copyright** and **Licensing**, specify the copyright and licensing information that you would like to appear on the About box in the app. This includes the copyright owner for the text. Use the drop-down list to select from a list of common rights holders or type in a different one.

If you will have audio in your app, also specify the rights holder to the audio recording, especially if they are different from the text rights holder.

You can also specify details the license, such as Creative Commons.

If you don’t know what to put in these fields, please ask the publishing department of your organisation for advice. They will want to make sure you get this right and do not simply make a guess as to what to include.

Click **Next** to move to the next page.

15. On the page of the wizard titled **Signing**, you need to specify the keystore and alias to use to sign the app. An app must be signed in this way so that it can installed on an Android device.

If you do not already have a keystore file (which you are unlikely to have if this is your first time using the program):

i. Click **Create New KeyStore Wizard**.

ii. Enter a new filename for the keystore, such as “test” or something like that. Specify a password.

iii. Click **Next** to continue.

iv. Enter an alias name for a key to create within your new keystore, such as “testkey”. Specify a password and enter at least one piece of information in the fields below.

v. Click **Next** to continue.

vi. A new keystore will be created for you. Click **Close**.

16. Back on the **Signing** page of the New App wizard, you need to specify the keystore password, select the alias and enter the alias password (just as you entered them in the step above).

Click **Next** to continue.

17. On the page of the wizard titled **Project**, you can enter modify the project name and add an optional description of the app project. Neither of these will be visible to the user of your app. They are just for your own use and might help you distinguish between multiple app projects.
Click **Next** to continue. The New App wizard will close and the app definition will be added to the tree view on the left of the screen.

18. Take a look at each of the app configuration pages by selecting them in the tree view on the left. Look in each of the tabs on each page to verify that you have the settings you want. You can always go back to them later to change them if you find you need to make modifications to fonts, colors, styles, etc.

19. When you have finished configuring the app, click on **Build App**.

   If something isn’t configured correctly for the build to work, you will be notified.

20. A black command box will appear. Wait about a minute while the app is compiled.

   The first time the build process is run, the compiler needs to connect to the internet to download some files. After this, subsequent app builds will not require internet access. See **Tools ➤ Settings... ➤ Build Settings** to turn on offline mode after the first app build.

21. If the build succeeds, you will have a new APK file – the installation file for an app. Copy this `.apk` file onto your phone or tablet and click on it to install it.

   This can be done automatically. See **Tools ➤ Settings... ➤ Build Settings** to install and launch the app on the attached device when the build finishes.

### 3. App Creation Basics

#### 3.1. How should I choose the app package name?

The standard for an app package name is to begin with the reversed web address of the publishing organisation, e.g. if it is Wycliffe Bible Translators, the package name could begin with:

```
org.wycliffe
```

and will be followed by something identifying the language and type of publication (New Testament, Bible, etc.), e.g.

```
org.wycliffe.xyz.bible
```

where `xyz` is the language name or code.
If you work for a Bible translation or publishing organisation, you might have standards to follow for package names, so please contact your digital publications coordinator for advice on this.

Once you publish your app on an app store, you cannot change its package name later if you want users to continue to receive updates. The package name uniquely identifies the app in the Android world. Those who install the app will be able to find its package name on their device. It will also appear in the web address for your app if you make it available on Google Play.

If you are building apps for test purposes on your devices, you can use a package name beginning with com.example, e.g.

\[
\text{com.example.test.app123}
\]

But remember to change it before you publish the app.

3.2. Where do the default book names and abbreviations come from?

If your books are in a Paratext project, the first place SAB will look for the book names is in the BookNames.xml file in the same folder as the USFM files. This file contains the names specified in the Scripture Reference Settings (found at Project ➔ Scripture Reference Settings… within Paratext):

![Scripture Reference Settings](image)

If your books are not in a Paratext project or if the Scripture Reference Settings are blank, SAB will look for the book names within the book files themselves. The USFM standard is to use `\toc2` for the short book name and `\toc3` for abbreviations:

\ toc1 The Gospel according to Matthew (long book name)
\ toc2 Matthew (short book name)
\ toc3 Mat (abbreviation)

If Scripture App Builder does not find `\toc2` or `\toc3`, it tries to guess the book name and abbreviation from `\mt` (main title) and `\h` (heading), but it is best to provide them in the toc fields.

For the Digital Bible Library text release bundles, the book names come from the metadata.xml file within the bundle.

You can change the book names and abbreviations on the book page for each book.

### 3.3. Do I have to create a new keystore for each app, or can I reuse the same keystore for several of my apps?

You can use the same keystore and key alias for all or several of your apps.

See here for more details:


### 3.4. How can I include pictures in my apps?

You can include JPG or PNG image files in the text of the app.

The app recognises the USFM illustrations markers `\fig`...`\fig*`:

`\fig DESC|FILE|SIZE|LOC|COPY|CAP|REF\fig*`

i.e. 7 parameters, separated by six vertical line characters.

The only required parameter is FILE – the filename. If the file extension is .tif, the app will look for a file with the same name but with a .png or .jpg extension instead.

You can optionally include captions (CAP) and chapter/verse references (REF).

Examples:

\fig picture1.jpg || |This is a picture|5:3\fig*
\fig picture2.tif || |This is another picture|\fig*
\fig picture3.jpg || |\fig*
\fig picture3.jpg\fig*
Include the image files in the app via the **Images ➤ Illustrations** page of Scripture App Builder. They will be included in the app assets and compiled into the final APK, so try to keep them as small as possible.

3.5. **How can I add a horizontal line to separate certain paragraphs in text?**

Use the marker \zhr to add a horizontal line. This will add a <hr> element in the HTML.

Please note that this is non-standard USFM, so this marker should not be used if you are submitting this same file to the Digital Bible Library.

3.6. **I don’t like the name “Scripture App”. Have you thought of calling the app something else?**

The program that allows you to define and build apps is called “Scripture App Builder” but the app itself doesn’t have a name. It is up to you to choose the names for the apps you build.

You will not see “Scripture App” anywhere in the apps you create, so feel free to use an appropriate name in an international, national or local language. App names that work well in certain contexts will be less helpful in other contexts, which is why SAB allows you to contextualise it.

3.7. **Can I build apps when I do not have internet access?**

The first time you build an app, you will need to be connected to the internet otherwise the compiler will fail. It will download a set of libraries used by the Gradle compiler. After that you can set the 'offline' version in **Settings** so you can work offline.

If you want to be able to build your first app without needing internet access, it is possible to copy the Gradle cache files from another computer that has already downloaded them. This will only work, however, if the absolute path to the files is exactly the same on the computer from which the files are taken as on your computer, e.g. “C:\gradle” on computer A and “C:\gradle” on computer B. It will not work if you have “C:\Users\John\gradle” or computer A and “C:\Users\Jenny\gradle” on computer B (which is the default Gradle cache folder).

So, on computer A, to get the cache files to distribute:

1. Go to **Tools ➤ Settings ➤ Build Settings ➤ Gradle Cache Folder**.
2. Enter “C:\gradle” and OK.
3. Build an app. The Gradle cache files will be downloaded to C:\gradle.

Then, on computer B:

4. Copy the C:\gradle folder from computer A to C:\gradle.
5. Go to **Tools ➤ Settings ➤ Build Settings ➤ Gradle Cache Folder**.
6. Enter “C:\gradle” and OK.
3.8. How do the glossary entry popups work?

It is possible to get the app to link words in the main Scripture text with glossary entries.

To get glossary links working, do the following:

1. Add a **glossary file** to the app as one of the books. A glossary file should have an id of GLO and each keyword should be marked with \k ..... \k*

```
\id GLO
\toc3 KkK
\toc2 Kafilakaya Ya Kóri
\c 1
\p \k Aba\k*: Yawutuu shi jomɔ pu wo kafila kaŋa ka ki ñe ke, ki kòri wu ñe: «To», kelee «baa», kelee «baba». Pëẹŋ mege ki ñe kii, taanra ñe kemu ni ge, lee na Yesu ya Kilɛ yiri na «Abà» (Galasi Shɛɛn 4:6).
\p \k Abeli\k*: Abeli bi bye Kayɛn wo cuun. Wee w’a pye Adama ni Awa ye wo ja shuun wo we. Kilɛ niy fyaara ni wu bi ñaarì (Macoo 23:35; Luka 11:51; Heburuu 11:4).
\p \k Ibirayima\k*: Ibirayima yi shi wa kënu shòɔɔni yaha wuye mu ge, wee w’a pye Yawutuu pu wo shi we. Ibirayima w’a pye pu sefële pu beéri wo to n’a daa wu ni.
```
2. Mark words in the main text with \w ..... \w*

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-new</td>
<td>Create a new app project</td>
</tr>
<tr>
<td>-load &lt;project&gt;</td>
<td>Load an existing app project</td>
</tr>
<tr>
<td>-build</td>
<td>Build app project (use with either -new or -load)</td>
</tr>
<tr>
<td>-no-save</td>
<td>Do not save changes to app (use with -load)</td>
</tr>
<tr>
<td>-?</td>
<td>Show command line help</td>
</tr>
<tr>
<td>-n &lt;app-name&gt;</td>
<td>Set app name. Enclose the name in &quot;double quotes&quot; if it contains spaces.</td>
</tr>
<tr>
<td>-p &lt;package-name&gt;</td>
<td>Set package name, e.g. com.myorg.language.appname</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td><code>-b &lt;filename&gt;</code></td>
<td>Add book or bundle file. This could be a USFM file or a zipped set of USFM files. It could also be a Digital Bible Library text release bundle.</td>
</tr>
<tr>
<td><code>-i &lt;filename&gt;</code></td>
<td>Include additional parameters file. Use the full path of the file and enclose it in &quot;double quotes&quot; if there is a space in the path.</td>
</tr>
<tr>
<td><code>-a &lt;filename&gt;</code></td>
<td>Set about box text, contained in text file. Use the full path of the file and enclose it in &quot;double quotes&quot; if there is a space in the path.</td>
</tr>
<tr>
<td><code>-f &lt;fontname&gt;</code></td>
<td>Set font name or filename, e.g. &quot;Charis SIL Compact&quot;, &quot;c:\fonts\myfont.ttf&quot;. The font name must be one of the items in the list of fonts in the New App wizard. For other fonts, specify the full path to the font filename.</td>
</tr>
<tr>
<td><code>-g</code></td>
<td>Use Grandroid</td>
</tr>
<tr>
<td><code>-ic &lt;filename&gt;</code></td>
<td>Add launcher icon (one or more .png files). Use the full path of the files and enclose them in &quot;double quotes&quot; if there is a space in the path.</td>
</tr>
<tr>
<td><code>-l &lt;lang-code&gt;</code></td>
<td>Set language for menu items and settings, e.g. en, fr, es</td>
</tr>
<tr>
<td><code>-ft &lt;feature=value&gt;</code></td>
<td>Set a feature, e.g. book-select=grid</td>
</tr>
<tr>
<td><code>-vc &lt;integer&gt;</code></td>
<td>Set version code, e.g. 1, 2, 3, or +1 to increment the current version code by 1.</td>
</tr>
<tr>
<td><code>-vn &lt;string&gt;</code></td>
<td>Set version name, e.g. 1.0, 2.1.4, or use +1, +0.1, +0.0.1 to increment the current value.</td>
</tr>
<tr>
<td><code>-ks &lt;filename&gt;</code></td>
<td>Set keystore filename. Use the full path of the file and enclose it in &quot;double quotes&quot; if there is a space in the path.</td>
</tr>
<tr>
<td><code>-ksp &lt;password&gt;</code></td>
<td>Set keystore password</td>
</tr>
<tr>
<td><code>-ka &lt;alias&gt;</code></td>
<td>Set key alias</td>
</tr>
<tr>
<td><code>-kap &lt;password&gt;</code></td>
<td>Set key alias password</td>
</tr>
<tr>
<td><code>-fp &lt;folder=path&gt;</code></td>
<td>Set a folder path, e.g. &quot;app.builder=c:\Scripture App Builder&quot;.</td>
</tr>
</tbody>
</table>

**Examples:**

```
sab -new -n "My App" -p com.example.myapp -b MyBookBundle.zip -f "Charis SIL Compact" -i keys.txt -build
```

```
sab -load "My App" -build
```
4. Fonts

If you are using a non-Roman script or a Roman script with combining diacritics, some Android devices will not display your fonts correctly. To overcome these problems, try using the Grandroid and/or Crosswalk libraries.

<table>
<thead>
<tr>
<th>Library</th>
<th>Purpose</th>
<th>Android Versions Supported</th>
<th>Additional Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grandroid</td>
<td>Rendering complex fonts and combining diacritics correctly in older versions of Android</td>
<td>Android 4.0, 4.1, 4.2, 4.3</td>
<td>400 KB</td>
</tr>
<tr>
<td>Crosswalk</td>
<td>Rendering complex fonts correctly in most versions of Android, especially fonts that are Graphite-enabled</td>
<td>Android 4.1 and above</td>
<td>18 MB</td>
</tr>
</tbody>
</table>

You can configure these on the Fonts ➤ Font Handling page.

4.1. What is Grandroid?

Grandroid (Graphite for Android) is a collection of native libraries from SIL Writing Systems Technology (WSTech). They can be packaged within the app, enabling older Android devices (versions 4.0 to 4.3) to make use of Graphite font rendering features.

Grandroid is not only about Graphite. It also fixes a few font display problems.

You can find more information about Graphite here:

You can find more information about Grandroid here:
[https://github.com/silnrsi/grandroid](https://github.com/silnrsi/grandroid)

4.2. When do I need to include the Grandroid libraries?

This will depend on the font and special characters you need to display. The more complex your script, the more likely you are to need Grandroid support.

Please note that if a font displays correctly on your own phone without Grandroid, it does not mean it will display correctly on all phones and Android versions. As well as testing your app on the latest version of Android, it would be a good idea to test it on a phone running Android 4.2 or 4.3 (which have known font display problems).

You will almost certainly need to include the Grandroid libraries:
- If you have a non-Roman script, e.g. Greek, Cyrillic, Armenian, Hebrew, Arabic, Syriac, Thaana, Devanagari, Grumukhi, Oriya, Tamil, Telugu, Kannada,
Malayalam, Sinhala, Thai, Lao, Tibetan, Myanmar, Georgian, Hangul, Ogham, Runic, Khmer, Ethiopic or NKo.

- If you have a Roman script which makes use of combining diacritics, such as separate acute accents or tone marks (e.g. ā, which is composed of two characters, but not é which is a single character).

You are unlikely to need to use Grandroid:

- If you have a simple Roman script which does not make use of combining diacritics. So that means a-z, plus other IPA characters such as epsilon, omega, etc. as long as they are not being combined with tone marks or accents.

If you try and display a complex script without Grandroid, you might find the following problems:

- The system font being used rather than the font you specify - on Android 4.2 and 4.3 (Jelly Bean).
- Lines with combining diacritics being displayed in the system font, while other lines are being displayed correctly - on Android 4.2 and 4.3 (Jelly Bean).
- A blank screen where there should be text - on Android 4.2 and 4.3 (Jelly Bean).

4.3. What is Crosswalk?

Crosswalk is a viewer component that replaces the standard Android viewer for Android versions 4.1 and above. It is based on the Crosswalk Project, created by the Intel Open Source Technology Center (https://crosswalk-project.org), and modified by SIL Writing Systems Technology (WSTech) to include support for Graphite font rendering.

The required Crosswalk library files will add at least 18 MB to your app size, so do not enable Crosswalk unless you know you need it to display your fonts correctly.

When you build your Android app with Crosswalk, you will get two output APK files:

- [apk-name]-arm.apk, for devices with ARM processors (the majority of smartphones and tablets), and
- [apk-name]-x86.apk, for devices with Intel processors.

In the screenshots below, the standard viewer is used in the left image and Crosswalk is used in the right image. Notice the dotted circles on the left, indicating that the font is not being rendered properly.
Using the standard viewer                                     Using Crosswalk

5. Audio

5.1. How can I associate audio files with the text?
Scripture App Builder allows you to use two different types of audio file:

- **Audio files that correspond to a page of text in the app**, e.g. the audio recording of a chapter of the Bible or the text in a picture story book. These can be linked to timing files to enable synchronised highlighting of the text when the audio is playing.
- **Short audio clips** which are played when the user taps a linked word, phrase or image in the app.

The first of these types of file is the most common in SAB apps and the instructions in this section will refer to these. For more information on using audio clips, please see section 5.5.

To associate audio with pages of text in your app, you will need **one audio file per chapter**. For example, if you have a book ‘Matthew’ with 28 chapters, you will need 28 audio files, one for each chapter.

- Matthew chapter 1  Bible-MAT-01.mp3
- Matthew chapter 2  Bible-MAT-02.mp3
- Matthew chapter 3  Bible-MAT-03.mp3, etc.
If you have several audio files per chapter or several chapters in one audio file, you will need to concatenate or split your files to create files of one chapter each before SAB can use them. This could be done in Audacity.

For picture story books, you can choose whether you have one audio file per page, or a single audio file for the whole book.

To add audio files:

1. Go to the Audio Files tab for the book, or the Audio Files tab for the book collection.
2. Click the Add Audio Files... button.
3. Select the audio files to add.

SAB will try to match the audio files to the chapters in the book(s), so you should use audio filenames that will make it obvious which file corresponds to which book and chapter.

The optional timing files can be added on the same page: one timing file per audio file.

5.2. How do I create the audio timing files for audio-text synchronization?
The timing files tell the app when to begin highlighting each verse or phrase.

There are three ways of creating these files:

1. Create the timing files manually using the Audacity audio editing program. For instructions, please refer to the document Using Audacity for Audio-Text Synchronization.
2. Automate the creation of the timing files using aeneas. For instructions, please refer to the document Using aeneas for Audio-Text Synchronization.
3. Use HearThis to record the audio. When you export the MP3 files, there is an option to export a set of timing files at the same time. For instructions, please refer to the document Using HearThis for Audio Recording.

5.3. How do I distribute the audio files with the app?

There are four ways of including audio files in your app: assets, external folder, internet download or FCBH download. You can use a single file source for all of the files in an app or you can combine two or more sources in an app.

To specify the file source(s) in Scripture App Builder, you need to visit the following two pages:

1. The Audio ➤ File Source page, which defines the available file sources.
This page can be found in the apps tree view just under Analytics on the top level of app pages. You can modify, add and remove file sources here.

2. The Audio Files tab for a book or book collection, which lists the audio files with their corresponding file source.

To change the source for a file or files, select the rows you want to change and select Change Source.

The follow sections describe the different file source types.

1. Assets
The audio files will be packaged inside the APK file for the app. This is the easiest method for a few files (e.g. one book) and requires no permissions. But be beware that the APK will get very large if you have several books of audio. The maximum size of an apk that can be uploaded to the Google Play store is 100 MB.

2. External Folder
No audio files are packaged within the app, so the APK is small. The app will look in a specified SD card folder to find the audio files it needs. If you are distributing the app via SD card, you include the folder of audio files on the SD card together with the APK. This method requires the 'Read external storage' permission but not internet access.

You can place the audio files inside sub-folders and sub-sub-folders in the specified SD card folder, using any folder names you choose.

For example, here are some possible folder names:

\Bible Files
  \1 Old Testament
    \01 Genesis
    \02 Exodus
  \2 New Testament
    \01 Matthew
    \02 Mark

or

\NT Mamara
  \01 Macoo
  \02 Marika
  \03 Luka
  \04 Yohana

There is no need to use 01, 02, etc. in the folder names, but these can be useful if folders are listed in alphabetical order
Alternatively, you can place all the audio files in a single folder without using any sub folders.

If the app does not find audio files in the specified folder or its sub-folders, it will also search the other folders on the device to see if it can find them there. For example, if the specified folder name is ‘Audio 123’ but the files are located in the ‘Audio 456’ folder instead, the app should find them. Once it has found a folder with a needed audio file, it will keep a note of it so it knows where to look next time.

3. Internet Download
Like method 2, no audio files are packaged within the app, so the APK is small. The app will look in a specified SD card folder to find the audio files it needs. If it doesn't find them there, it will look in all the other folders on the device. If it still cannot find them, the app can download the files one by one when it needs them from a website of your choice. This method requires the 'Read external storage', 'Write external storage', 'Connection state' and 'Internet' permissions.

Audio filenames
The internet download works best if your audio filenames do not include any spaces. A filename of the form “LNG-MAT-01.mp3” is better than “LNG MAT 01.mp3”.

Audio file hosting
Recommended storage locations for the files on the internet include:

- A language-specific website
  If you have a language-specific website for making resources available for download, you could place the audio files in a folder on the website.
  For example, if your website is called ‘www.ourlanguage.org’, you could upload the audio files to a folder called ‘audio’. The http address for your audio files would then be: http://www.ourlanguage.org/audio
  Your website administrator should be able to help you do this.

- Internet Archive
  Archive.org (http://www.archive.org) is a non-profit library where you can create a free account and upload your audio files. As well as being accessible to your app, the files will be freely available on the archive.org website for users to view and download.

- Cloud Storage Services
  Amazon S3 (Simple Storage Service): http://aws.amazon.com/s3/
  Google Cloud Storage: https://cloud.google.com/storage/
  These cloud storage services are designed for fast, reliable and secure online storage. Once you have created an account, you create a 'bucket' in which to place your audio files. When you add the files, you need to make them public
and make a note of the web address link to use to access them, e.g. 
http://s3.amazonaws.com/yourbucketname

You will get some months of free storage before there is a charge according to 
the bandwidth used, i.e. how many MB of audio users download. It might be 
easiest to organise this kind of cloud storage at an organisational level rather 
than creating a new account for each language.

4. FCBH Digital Bible Platform
If the audio files that your app uses come from Faith Comes By Hearing (FCBH), there is 
no need to upload them to the internet. They are already there and can be accessed via 
the Digital Bible Platform (DBP). This is the server used by the Bible.is website and 
Bible.is mobile app. Take a look at the Bible.is website to see if the language you are 
interested in is already available.

If you have any non-FCBH Scripture recordings, those you have recorded in-house with 
the help of your own organisation’s technicians, FCBH is willing to consider hosting 
these files as well in the DBP. This applies, for example, to good quality recordings of 
complete Bible books – but not Bible story portions or teaching materials. To investigate 
this option, please contact your area FCBH representative.

For your app to be able to download files from the DBP, you will need to register with 
FCBH and provide your app with the DBT (Digital Bible Toolkit) key, received on 
registration, and volume id of the set of audio files. This method requires the 'Read 
external storage', 'Write external storage', 'Connection state' and 'Internet' permissions.

When building your app, you will need to have downloaded the FCBH audio files onto 
your computer and add them to the Audio Files page. This is so SAB can see the 
filenames and allow you to create corresponding timing files for text-audio 
synchronization. The files are used for the app building process and will not be 
packaged within the APK file.

Getting a DBT key
The DBT key (the API Key) is a 32-character alpha-numeric string.

To get a key, you need to register with FCBH:

1. Go to http://www.digitalbibleplatform.com
2. Click Sign Up on the top right of the screen.
3. Click Sign Up for Developer Access.
4. Fill in your details, mentioning that you are building apps with Scripture App 
Builder and hit Submit.

Getting the DAM ID
When you get your DBT key from FCBH, you'll be able to search the library of volumes 
to get the DAM ID for the language audio you need.
The DAM ID is a 10-character string which uniquely identifies the set of audio files for a language, e.g. “MYKWBTN2DA” (for the Minyanka NT), “TPIPNGN2DA” (for the Tok Pisin NT).

2. Go to the Volume Listing page. You can find this in the menu on the left of the screen, under API Reference ➢ Library Catalog.
3. Scroll down the page to the API Explorer.
4. Type your DBT key into key (required):
5. Type the language code into language_code.
6. Click the Test button.
7. In the list of volume results, look for the DAM ID of the volume which has audio content (rather than text content):
   "media": "audio"

5.4. How are the timing files distributed for the app?
If you have timing files for audio-text synchronisation, they are always packaged in the app assets whatever the audio source setting chosen in 5.3 above. They are not downloaded from anywhere.

If timing files are not available when the app is compiled and are subsequently created by someone who isn't building the app (such as a volunteer), they can be placed in the external folder for testing. For more details, please see section 6.7 in the document Using Audacity for Audio-Text Synchronization, which answers the question “I’d like to give someone else the task of creating timing files. Is there any way of them testing these without needing to know how to build the app?”

5.5. How can I use audio clips in the app?
Audio clips are short audio files which are played when the user taps a linked word, phrase or image in the app.

To include an audio clip in your app:

1. Select the Audio page for the app, and go to the Audio Clips tab.
2. Click Add Audio Clips... and select the audio file you want to add.
3. Add a hyperlink to this audio file in your text.
   You can do this using the markdown format with [] and (), e.g.
   [Click me to hear this word](word1.mp3)
or if your text is in a Word document, select a word or a phrase, right-click, Hyperlink... and enter the audio filename as the address to link to.

Specify the audio filename without a path, e.g. “word1.mp3” rather than “C:\My clips\word1.mp3”.

6. Video

6.1. How do I include videos in the app?

The app can handle two types of video:

- **Videos hosted online for streaming**, e.g. YouTube, Vimeo, Jesus Film videos, and MP4 streaming video files.
- **Videos for offline use**, MP4 files which can be packaged within the app assets, distributed on memory cards, or downloaded from the internet for use and sharing offline.

To add an online video:

1. Select the Video page in the app builder.
2. Click Add Videos...
3. Select Online streaming video, from YouTube, Vimeo, etc., and click Next.
4. Enter the video URL in the Online Address field, e.g. http://www.youtube.com/watch?v=ABcDEdGHiJ.
5. Click Finish.
6. Double click on the video item in the table.
7. Specify a title (optional).
8. Select or modify the thumbnail image on the Thumbnail tab.
To add an offline MP4 video file:

1. Select the Video page in the app builder.
2. Click Add Videos…
3. Select Video files in MP4 format, and click Next.
4. Click Add Videos… and select the MP4 video files to add.
5. Click Finish.
6. Double-click on each video to edit its title (optional) and thumbnail image.

The next thing you need to do is tell the app builder where to insert and display the videos.

6.2. How do I specify where the videos will be displayed within the app?
There are three ways of inserting videos into the text:

- **Placement within Scripture**: Use the third tab, Placement, in the Edit Video dialog to specify a position within a chapter of Scripture: before or after a given verse or at the top or bottom of a page.

- **Video markers in SFM book files**: Use the \video marker, together with the ID of the video within an SFM book file, e.g.

  \s This is a sub heading
  \p Here is an example video to view:
  \video V1
  \p Here is another video:
  \video V2

- **Video markers in Word documents**: Use the word VIDEO:, together with the ID of the video within a book’s Word document, e.g.

  This is a sub heading
  Here is an example video to view:
  VIDEO: V1
  
  Here is another video:
  VIDEO: V2

  The VIDEO: tag should be at the start of a new paragraph, and include a colon (:) before the video ID.
7. About Page

Every app must have an About page, which is displayed to the user when they select About from the bottom of the app’s navigation drawer menu.

To define the About page for your app:

1. Select About in the apps tree view on the left of the screen.
2. Enter the text to be displayed on the app’s About page.
3. Select the Viewer tab to see how the text will appear in the app.

7.1. What information should I include in the About page?

The About page can contain any information. What you include is your choice, but commonly included items include:

- The app name and version
- The name of the organisation publishing the app
- Copyright and license information for the contents of the app (texts, images, audio). In most cases, the license agreements will require you to include such information.
- Link to your website
- Link to a privacy policy
- Contact information, such as an email address or phone number.

7.2. Which formatting codes can I use in the About page?

You can use the following formatting codes:

<table>
<thead>
<tr>
<th><strong>Bold text</strong></th>
<th>Surround the text you want in bold with <code>&lt;b&gt;</code> and <code>&lt;/b&gt;</code> markers. Example: <code>&lt;b&gt;This is in bold&lt;/b&gt;</code></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Italic text</strong></td>
<td>Surround the text you want in bold with <code>&lt;i&gt;</code> and <code>&lt;/i&gt;</code> markers. Example: <code>&lt;i&gt;This is in italics&lt;/i&gt;</code></td>
</tr>
<tr>
<td><strong>Underlined text</strong></td>
<td>Surround the text you want in bold with <code>&lt;u&gt;</code> and <code>&lt;/u&gt;</code> markers. Example: <code>&lt;u&gt;This is underlined&lt;/u&gt;</code></td>
</tr>
<tr>
<td><strong>Website links</strong></td>
<td>Use the format <code>[text](url)</code>, where ‘text’ is the text to display and ‘url’ is the web address. Example: Here is our <a href="http://www.example.com">website</a></td>
</tr>
</tbody>
</table>
### Email links
Use the format `[text](mailto:address)`, where ‘text’ is the text to display and ‘mailto:address’ contains the email address.

Example: Contact us by `[email](mailto:contact@example.com)`

### Phone numbers
Use the format `[text](tel:number)`, where ‘text’ is the text to display and ‘tel:number’ contains the number to call.

Example: Our number is `[012-345-678](tel:012345678)`

### Image
To add an image, first add the image file to the app illustrations (Images > Illustrations) and use the following HTML code:

```html
<img src="image1.jpg"/>
```

You can specify width information, as a percentage (e.g. "80%") or a fixed number of pixels (e.g. "80px"):

```html
<img width="80%" src="image1.jpg"/>
```

### Left, right or centered alignment
To align text or images, surround them with the following `<div>` markers:

- `<div align="center">This is centered</div>`
- `<div align="left">This is left aligned</div>`
- `<div align="right">This is right aligned</div>`

To center an image:

```html
<div align="center"><img width="75%" src="img2.jpg"></div>
```

### Styles
To apply styles (defined in the Styles page):

```html
<div class="q2">This is styled as poetry</div>
```

### Fonts
To apply specific fonts to text, first make sure that the fonts are specified on the Fonts page. Then use the following syntax:

```html
<span style="font-family:font1;">This is in font1</span>

<span style="font-family:font2;">This is in font2</span>
```

### 7.3. Which variables can I use in the About page?
You can use certain variables on the About page. These are replaced by text in the app. For example, the variable `%version-name%` will be replaced by the app version number, e.g. “1.2” in the app.
<table>
<thead>
<tr>
<th>App name</th>
<th>To display the app name, use the variable %app-name%</th>
</tr>
</thead>
<tbody>
<tr>
<td>App version</td>
<td>To display the app version, use the variable %version-name%</td>
</tr>
<tr>
<td>Copyright</td>
<td>To display copyright information for text, audio and images:</td>
</tr>
<tr>
<td></td>
<td>%copyright-text:CCC% text copyright, for collection CCC</td>
</tr>
<tr>
<td></td>
<td>%copyright-audio:CCC% audio copyright, for collection CCC</td>
</tr>
<tr>
<td></td>
<td>%copyright-images:CCC% images copyright, for collection CCC</td>
</tr>
<tr>
<td></td>
<td>Replace CCC by the ID of the book collection, e.g. “C01”. The information comes from the Copyright &amp; Licensing tab for that book collection.</td>
</tr>
<tr>
<td>Licence</td>
<td>To display license information for text, audio and images:</td>
</tr>
<tr>
<td></td>
<td>%license-text:CCC% text license, for collection CCC</td>
</tr>
<tr>
<td></td>
<td>%license-audio:CCC% audio license, for collection CCC</td>
</tr>
<tr>
<td></td>
<td>%license-images:CCC% images license, for collection CCC</td>
</tr>
<tr>
<td></td>
<td>Replace CCC by the ID of the book collection, e.g. “C01”. The information comes from the Copyright &amp; Licensing tab for that book collection.</td>
</tr>
</tbody>
</table>

### 8. Multiple Translations

You can include more than one Bible translation or script in your app, for example:

- A local language translation together with a translation for a neighbouring language.
- A local language translation together with a translation in a major language such as English or French.
- A translation in Roman script together with the same translation in a different script such as Arabic.
- A translation together with the original language texts in Hebrew or Greek.

You are not limited to two translations. You can choose to include three or more translations if you need to. However, the more translations you include, the bigger your app will become.
8.1. Three different layouts

Multiple translations can be displayed in the app in one of three layouts:

1. **Single Pane**: view one translation at a time, in the same way as you would in an app with a single translation.

2. **Two Pane**: view two translations at a time. In portrait mode, the translations will be displayed one on top of the other. In landscape mode, the translations will be displayed side by side. The user can drag the separator line up/down or left/right to change the amount of screen space allocated to each translation.

3. **Verse-by-Verse**: view two or three translations at a time, with each being displayed verse by verse, i.e. verse 1 in translation A, followed by verse 1 in translation B, verse 2 in translation A, verse 2 in translation B, etc. The different translations will be displayed in different colour fonts.

![Single Pane Layout](image1)

![Two Pane Layout (portrait)](image2)
Within the app, you can choose to give the user the permission to configure these layouts. To access the layout configuration dialog, the user taps on the name of the language at the top right of the viewer.
8.2. How to add a translation to the app
To add a translation to the app within Scripture App Builder:

1. Select the Books node for the app in the treeview on the left of the SAB screen.
2. Click Add Book Collection... to launch the Add Book Collection wizard.
3. Enter a name and abbreviation for the new book collection.
4. Click Next.
6. Click Next (and Next again if you see the page about book names)
8. Go to the About box page and add the copyright and licensing information for this book collection.

8.3. How to configure the Layouts dialog
To configure what the user will see within the Layouts configuration dialog:

1. Select the Books node for the app in the treeview on the left of the SAB screen.
2. Go to the Layouts tab.
3. Choose the default layout and default book collections for each layout type. You can choose to allow the user to select between any of the layout types (Single Pane, Two Pane and Verse-by-Verse) or only one or two of these.
9. **Navigation Drawer**

You can customise the image that appears at the top of the navigation drawer. It can be a photo, your organisation’s logo or any relevant graphic design.

Specify a landscape image file on the **Images ➤ Navigation Drawer** page.
10. Contents Menu

When the user launches the app you might want to display a contents menu, giving them an easy way to jump to books and specific references. The contents menu contains a list of images and titles.

10.1. How do I create a contents menu?

To create a contents menu for your app:

1. Select the Contents Menu page in the Apps tree view on the left of the screen.

2. Ensure that the first tab, Contents Items and Screens, is visible.

3. For each contents menu item you want to add, click the Add Item... button and follow the wizard to add the item to the screen. You will need to specify:
   
   - The target reference, such as Luke 15 verse 1.

   This reference can be a book name, or a book and chapter, or a book chapter and verse. If you have multiple book collections, you can specify an associated layout.

   - The title of the item, such as ‘The Lost Sheep’

   - An optional subtitle

   - An image (optional) – to appear to the left of the title.
4. You can reorder the items on the screen by selecting rows in the table and dragging up or down.

5. Go to the **Contents Settings** tab to specify display formatting and navigation options for the menu.

6. Select the **Viewer** tab to see how the contents menu will appear in the app.

10.2. **How do I create additional contents menu screens?**

In some cases, you might want to have multiple contents screens, i.e. you select an item in the first screen and it takes you to a second contents screen.

To add a contents screen:

1. Click the **Add Screen**... button and give the screen a name.

2. Click the **Add Item**... button and specify its target to be **Another menu screen** and select the name of your new screen. This will mean that when the user taps on this item in the first screen they will be taken to your new screen.

3. Add menu items to your new screen as described above.

4. You can move items between screens by dragging item rows up or down.
11. Verse on Image

11.1. The Verse on Image editor in the app

If you tap on a verse in the app, it will be selected (underlined) and the text selection toolbar will appear at the bottom of the screen. On this toolbar you can tap the image button which will take you to the Verse on Image editor:

You can change the following **text attributes**:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Text attribute</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Text position" /></td>
<td>Text position (drag the text around the image with your finger)</td>
</tr>
<tr>
<td><img src="image" alt="Text width" /></td>
<td>Text width (pinch the text or use the slider)</td>
</tr>
<tr>
<td><img src="image" alt="Text font" /></td>
<td>Text font</td>
</tr>
<tr>
<td><img src="image" alt="Text size" /></td>
<td>Text size</td>
</tr>
<tr>
<td><img src="image" alt="Bold or italics" /></td>
<td>Bold or italics</td>
</tr>
<tr>
<td><img src="image" alt="Letter spacing" /></td>
<td>Letter spacing</td>
</tr>
</tbody>
</table>
If you double-tap the text, you can edit the text itself.

You can change the following background image attributes:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Image" /></td>
<td>Image selected from one of the built-in images</td>
</tr>
<tr>
<td><img src="image" alt="Image" /></td>
<td>Image selected from the photo gallery on your phone or tablet</td>
</tr>
<tr>
<td><img src="brightness" alt="Brightness" /></td>
<td>Brightness</td>
</tr>
<tr>
<td><img src="contrast" alt="Contrast" /></td>
<td>Contrast</td>
</tr>
<tr>
<td><img src="saturation" alt="Saturation" /></td>
<td>Saturation</td>
</tr>
<tr>
<td><img src="blur" alt="Blur" /></td>
<td>Blur</td>
</tr>
</tbody>
</table>

When you are happy with the text and image, use the buttons at the top right of the screen to save the image or share it with others.

If you have audio and timing files for the selected verse, it is possible to share the image as a video with the text and audio combined.
11.2. Configuring Verse on Image in the app builder

The Verse on Image editor is turned off by default. To enable it in the app builder:

1. Go to the Features ➤ Verse on Image tab.
2. Select Include the ‘Verse on Image’ editor in the app.
3. Select Allow saving as a video, combining the image and audio, if you have audio and want to enable the video sharing feature. This will require the image processing library, FFmpeg, to be included within the app.
4. Go to the Images ➤ Backgrounds tab.
5. Add some background images. You can get them from:
   - The gallery of images in Scripture App Builder, by clicking the button Choose from Gallery...
   - Photos of local scenery that you, friends and colleagues have taken.
   - Images downloaded from websites such as pexels.com, unsplash.com and pixabay.com.
6. Go to the Fonts ➤ Font Files tab.
7. Add some more fonts if you want to give the user a choice of fonts in the image editor. If you do not specify additional fonts, the font tab will not be displayed in the app.
12. Verse of the Day

12.1. Verse of the Day notifications

Your app can be configured to send a daily verse of the day. The verse appears as a notification in the device’s notification tray. When you tap on it, the app will open and highlight the verse.

These notifications work offline. They are sent from the app rather than being sent over the internet. The user can set their preferred time of day for the notification in the app Settings screen.

12.2. Configuring Verse of the Day in the app builder

By default, Verse of the Day notifications are not included in the app. To configure them in the app builder:

1. Go to the Notifications ➤ Verse of the Day tab.
2. Select Include Verse of the Day in this app. If this option is not selected, Verse of the Day will not be included in the app and the app user will not be able to turn it on.
3. If you want the notifications to be turned on by default, select **Turn on Verse of the Day notifications by default**. If this option is not selected, the user will need to go to the Settings screen in the app in order to turn on the notifications.

4. Choose a default **time of day** for the Verse of the Day to appear. The user will be able to change this in the app Settings.

5. Choose the appropriate **Christmas** and **Easter** date traditions.

6. Specify whether the verse can be displayed using the standard system font or whether it needs to be displayed using a custom font. We recommend you select the system font unless you have a more complex script that cannot be displayed well in such fonts.

7. Move to the **Notifications** ➤ **Verses** tab.

8. Review the verses chosen for each day of the year and for the special dates. You can edit individual verses.

### 13. Highlighting, Notes and Bookmarks

If you tap a verse in the app, it will be selected (underlined) and the text selection toolbar will appear at the bottom of the screen. From this toolbar you can choose to highlight the selected text, add a note, place a bookmark, play audio beginning at this verse, copy the text to the clipboard or share it.

#### 13.1. Highlighting

To highlight one or more verses:

1. Tap on the verse or verses. The app will underline them.
2. Select the highlighter pen button from the text selection toolbar.
3. You will get a choice of highlighter pen colours: yellow, green, orange, blue and pink. Tap on one of them.
To remove a highlight:

1. Tap on the verse or verses for which you want to remove the highlighting.
2. Select the highlighter pen button from the text selection toolbar.
3. Choose the white colour to remove the highlighting.

To view a list of highlighted verses, select Highlights from the app’s navigation drawer menu. On this screen you can sort highlights by date, reference or colour (tap on the Sort button on the app bar). You can delete highlights or tap on an item to go to the highlighted verse. You can also share the list of highlighted verses with someone else (tap on the Share button on the app bar).

### 13.2. Notes

App users can add personal reflections, teaching notes, feedback on the translation, etc.

To add a note to a verse:

1. Tap on the verse. The app will underline it.
2. Select the Note button from the text selection toolbar.
3. The Add Note screen will appear. Type the note. Special characters can appear as buttons as on the Search screen.
4. Save the note using the tick button on the toolbar. A note icon will be displayed at the end of the verse. Tap on this icon to see the note in a popup window at the bottom of the screen. Tap on the edit icon to enter the Edit Note screen.
To view a list of notes, select Notes from the app’s navigation drawer menu. On this screen you can sort notes by date or reference (tap on the Sort button on the app bar). You can edit or delete notes or tap on an item to go to the verse with the note. You can also share the list of notes with someone else (tap on the Share button on the app bar).

You can use the notes sharing feature to allow reviewers in the language community to send feedback on a translation. For this, specify an email address and subject line in the app builder on the Features ➤ Annotations tab.

13.3. Bookmarks
To add a bookmark to a verse:

1. Tap on the verse. The app will underline it.

2. Select the bookmark button from the text selection toolbar. A red bookmark icon ▪️ will be displayed at the end of the selected verse.
To remove a bookmark from a verse:

1. Tap on the bookmark icon  at the end of the verse. The app will underline the verse.
2. Select the red bookmark button from the text selection toolbar. The bookmark will be removed.

To view a list of bookmarks, select Bookmarks in the app’s navigation drawer menu. On this screen you can sort bookmarks by date or reference (tap on the Sort button on the app bar). You can delete bookmarks or tap on an item to go to the verse with the bookmark. You can also share the list of bookmarked verses with someone else (tap on the Share button on the app bar).

13.4. Configuring highlights, notes and bookmarks
When building your app, you can choose to turn on or off highlights, notes, bookmarks, as well as other actions on the text selection toolbar.
Do this on the Features ➜ Annotations tab.

13.5. Questions about highlights, notes and bookmarks
Here are some questions you might be asking:

Q. Can users highlight phrases in a book introduction or in a non-Scripture book?
   o Highlighting, notes and bookmarks are currently limited to chapters with verses. Users cannot highlight titles or sub-headings, just verses of Scripture.
Q. *Can users highlight a few words within a verse rather than the whole verse?*

- No, only full verses can be highlighted. A single tap to select a verse provides a simple interface for users and is much easier to do than dragging start and end cursors to select a string of words.

Q. *Can users synchronise their highlights, notes and bookmarks with another device?*

- No, not at the moment. We hope this will be coming in a future version.

14. **Borders**

You can add a decorative border frame around the text in the app, for example:

14.1. **How do I add a border to the app?**

You can select a border from the gallery of border images supplied with Scripture App Builder, or you can create your own border.

To select a border from the border gallery:

1. Go to the **Images ➤ Border** tab.
2. Click **Choose from Gallery**…

3. Select an image from the gallery and click OK.

To add your own border:

1. Create the border as an image file (JPEG or PNG) in portrait orientation. Ensure that the middle rectangular area of the image is blank. This blank area is where the text will be displayed.

You do not need to provide a border image in landscape orientation. This will be generated automatically. It does not matter too much what the width-to-height ratio of the image is, since the app will cut up the border and arrange it for different screen sizes.

Try not to make the border too wide, otherwise there will be limited space to display the text.

2. Go to the **Images ➤ Border** tab.
3. Click **Add Image**... and select the border image.

4. Ensure that the checkbox **Include a border around the text in this app** is selected.

5. If you want to display the border for some books and not others, or on main chapters but not book introductions, go to the Features page for each book and modify the **Show border around text** and **Show border around introduction** settings.

14.2. **How does the app draw the border image?**

Scripture App Builder takes the border image file you provide and finds the blank rectangle area inside of it. It then cuts up the remaining image into 8 pieces: top-left corner, top, top-right corner, left, right, bottom-left corner, bottom and bottom-right corner.

When the border is displayed on the app screen, the corner images are scaled according to the screen size, and the side, top and bottom images are scaled and stretched to fill the space between the corners. In this way, the border adapts itself to display with different screen sizes. This technique allows the app to display the border in full screen view, or when there is an audio toolbar displaying at the bottom.
15. Picture Story Books

A picture story book is a book with a picture at the top of each page and a few sentences of text underneath. In the app, the picture will stay at the top of the screen and the text will scroll.

Audio-text highlighting works as it does for Scripture text, and when the audio reaches the end of a page the app will move to the next page of the story.

When the device screen is in landscape orientation, the picture will be displayed to take up the whole screen. If you specify a timing file alongside the audio file, each phrase will be displayed as a subtitle over the image.

You can choose to associate a single audio file with the whole picture story book, or one audio file per page.
15.1. **How do I define a picture story book?**

Picture story books can be defined in one of two formats:

- Microsoft Word (.docx) documents, or
- Text files using standard format markers (SFM).

See 13.2 and 13.3 for a description of these formats.

15.2. **What do picture story books in Word documents look like?**

To create a Microsoft Word document to define a picture story book:

2. Insert a picture at the top of the first page.
3. Add the story text for this page below the image.
4. Insert a page break after the text using **CTRL+Enter**, or **Insert > Page Break**.
5. Insert a picture at the top of the second page and place the story text under it.
6. Insert a page break after the text using **CTRL+Enter**, or **Insert > Page Break**.
7. Continue adding additional pages in this way.
8. Save the document in **.docx** format.
You can add images to the document in .jpeg, .jpg, .png, .tif or .gif formats and Microsoft Word will convert them automatically to the format recognised by Scripture App Builder.

If you have large image files it is best to resize them. You can do this either before adding them to the document or within Word itself:

1. Select one of the images in Word.
2. Click **Compress Pictures** on the picture format ribbon or toolbar.
3. Select **All Pictures in document**.
4. Select the resolution as **Web/Screen**.
5. Click **OK**.
6. Save the document.

15.3. **What do picture story books in SFM format text files look like?**

They start with an id of your choice:

\id STO29

and a title:

\toc2 The Story of the Unmerciful Servant

Each page begins with the \page marker:

\page 1
One day, Peter asked Jesus, “Master, how many times should I forgive my brother when he sins against me? Up to seven times?”

Jesus said, “Not seven times, but seventy times seven!”

By this, Jesus meant that we should always forgive. Then Jesus told this story.

Here is an example:

------------------------------------
\id STO29
\toc2 The Story of the Unmerciful Servant

\page 1
\img obs-29-01.jpg

One day, Peter asked Jesus, “Master, how many times should I forgive my brother when he sins against me? Up to seven times?”

Jesus said, “Not seven times, but seventy times seven!”

By this, Jesus meant that we should always forgive. Then Jesus told this story.

\page 2
\img obs-29-02.jpg

Jesus said, “The kingdom of God is like a king who wanted to settle accounts with his servants. One of his servants owed a huge debt worth 200,000 years’ wages.”

\page 3
\img obs-29-03.jpg

Since the servant could not pay the debt, the king said, ‘Sell this man and his family as slaves to make payment on his debt.’

\page 4
\img obs-29-04.jpg

The servant fell on his knees before the king and said, ‘Please be patient with me, and I will pay the full amount that I owe you.’ The king felt pity for the servant, so he canceled all of his debt and let him go.”

etc.

The book files must be plain text files. If you have Unicode characters, the text files should use UTF-8 encoding. To create a text file in Windows, use a text editor such as Notepad. To create a text file on a Mac, use TextEdit, remembering to choose Plain text files in the preferences because otherwise the default file type is RTF (which contains a lot of additional formatting codes).
15.4. Where do the pictures go?
If you have defined the picture story book as a Word document, the images in the
document will be added automatically to the app illustrations collection when you add
the book. You can see them on the Images ➔ Illustrations page.

If you have defined the picture story book as an SFM text file, you need to add the
images to Scripture App Builder separately. Do this on the Images ➔ Illustrations page.
You can use either PNG or JPG files. Try and make them as small as possible without
compromising image quality. This will keep your app size small and reduce page load
time.

15.5. How can I get the pictures to move when the audio is playing?
You can add pan and zoom effects to the images when the audio is playing. To specify
the motion:

1. Go to the Story Pages tab for the book.
2. Select an image at the top of the page.
3. Select the Motion tab below the images.
4. Select Specify the start and end positions.
5. Drag and resize the start and end rectangles in the images to specify the start
   and end positions.
6. Do this for each image in the book.
15.6. What about font and font size?
A popular font designed for those learning to read is Andika or Andika Compact.

If you have a small amount of text per picture, it is best to use a larger font size by default. You can change this within Scripture App Builder on the Styles ➤ Text Styles page by modifying the font-size property of the body style.

15.7. What audio timing labels are used?
If you have one audio file for the whole book, timing labels are of the form:

- 1a - 1st phrase on page 1
- 1b - 2nd phrase on page 1
- 1c - 3rd phrase on page 1
- 2a - 1st phrase on page 2
- 2b - 2nd phrase on page 2, etc.

If you have one audio file per page, timing labels are of the form:

- a - 1st phrase on the page
- b - 2nd phrase on the page
- c - 3rd phrase on the page

To help with the creation of the timing files, generate phrase lists on the Audio Synchronization page for the book, or use aeneas to automate the synchronization process.

15.8. How can I add background music when the audio is playing?
You can add background music and sound effects behind the audio narration track. To do this:

1. Go to the Story Pages tab for the book.
2. Select the first image at the top of the page.
3. Select the Background Music tab below the images.
4. Select Play this audio file as background music.
5. Click Select File... and choose the background music audio file.
6. Drag the slider to modify the volume of the background music.

7. Select each of the following pages in the book and specify whether to Continue playing the background music from the previous page, whether to play a different background music track or whether to stop playing any background music.

15.9. Where can I get sample story book text and pictures?
Have a look at Open Bible Stories here: https://door43.org/en/obs

15.10. How can I record the audio files?
Use your favourite sound recording software, such as Audacity. You will need to decide how fast or slow you want the reader to read. In some contexts, it might be good for picture story books to be read fairly slowly.

16. Song Books

16.1. How do I define a song book?
You can build a song book app, with one song per 'chapter'. Song books are defined in one of two formats:

- Microsoft Word (.docx) documents, or
• Text files using standard format markers (SFM).

See 14.2 and 14.3 for a description of these formats.

Audio can be added with audio-text synchronization so that each line of the song is highlighted as it is sung.

16.2. What do song books in Word documents look like?
To create a Microsoft Word document to define a song book:

2. Type the songs or copy them from another document.
3. For each song, place the song number on a line by itself before its corresponding title and lyrics.

![Song Book in Word Document](image)

1
Ala Tanu! Aleluya!

An k’Ala tanu
Ala Dënfë ko la,
O sara ka kunun
Ka ñënamay a.

Ala Tanu! Aleluya!
Ala Tanu! Añïïna!
Ala Tanu! Aleluya!
Yesu ñë na tun.

An bëë tununna
Dibi Fanga de la,
Bari Matigë nana,
A ye an bëë tila.
4. Create the following paragraph styles:

<table>
<thead>
<tr>
<th>Style</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>c</td>
<td>Chapter number</td>
</tr>
<tr>
<td>s</td>
<td>Song title</td>
</tr>
<tr>
<td>q1</td>
<td>Line of the song</td>
</tr>
<tr>
<td>q2</td>
<td>Line of a chorus (more indentation)</td>
</tr>
</tbody>
</table>

To create a style:

a. Select the line/paragraph of text that corresponds to this style, i.e. if you are creating the style ‘c’, select one of the lines with a song number. If you are creating the style ‘q1’, select a line of the song lyrics.

b. Click on the down arrow to the right of the styles ribbon.

c. Then select **Create a style** from the menu that appears.

d. Type the style name into the dialog box and press OK.

Do this for c, s, q1 and q2.
5. Apply the above styles to all the chapter numbers, song titles and the lines of the song lyrics.

To apply a style:

a. Select the line/paragraph to which you want to apply the style.

b. Click on the down arrow to the right of the styles ribbon.

c. Select the style you want to apply.
Tip: The F4 key can be useful as you apply the styles to repeat your previous action.

All of the songs are contained within a single Word document.

6. Save the document in .docx format.

16.3. What do song books in SFM format text files look like?
They start with an id of your choice:

```
\id SONGS
```

and a title:

```
\toc2 Our Song Book
```

Each song begins with the \c marker and the number of the song:

```
\c 1
```

The marker \q (or \q1) is used for line of the song lyrics and \q2 for indented lines, such as for a chorus.

Use \b for blank lines between verses.
If you are used to using Paratext, these SFM codes will be familiar since they are how you mark up poetry in such as Psalms.

All of the songs are contained within a single file.

The SFM songbook file must be a plain text file. If you have Unicode characters, the text files should use UTF-8 encoding. To create a text file in Windows, use Notepad. To create a text file on a Mac, use TextEdit, remembering to choose Plain text files in the preferences because otherwise the default file type is RTF (which contains a lot of additional formatting codes).
16.4. How can we associate audio with each song?
A separate audio file and corresponding timing file needs to be created for each song.

Timing labels are of the form:
- a - 1st line of the song
- b - 2nd line of the song
- c - 3rd line of the song
- d - 4th line of the song, etc.

To help with the creation of the timing files, generate phrase lists on the Audio Synchronization page for the book.

Automated synchronization is unlikely to work for songs, so you will need to use the manual tagging method using Audacity and Timing Labels Assistant. Please see the document Using Audacity for Audio Text Synchronization for instructions.

17. Sharing Apps

A Share App item can be added to the app navigation drawer menu to enable users to share the app with others. You can configure this on the Features ➤ Sharing page.
There are two ways of sharing the app. You can choose to allow the user to use one or both of them:

- **Share Link to App on Google Play**: this option allows the user to send someone the link to the app on the Google Play store, e.g. by email or social media. You should enable this only if the app has been published on Google Play.

- **Share App Installer File**: this option allows the user to share the APK file with another device, e.g. by Bluetooth, Wifi transfer or email. This option is especially useful in contexts where not everyone has easy internet access and where you want to promote offline app sharing.

### 18. Deep Linking

Deep Linking allows you to direct people to specific pages within the app, using a link on a website, in a messaging app, social media or email.

A deep link can look something like this:

- mamara-bible://LUK.15
- https://mamara.org/bible/LUK.15
- https://www.wycliffe.org/mexico/huichol/bible?ref=LUK.15

If you share one of these links with a friend on WhatsApp, Facebook or email, and they tap on the link on their smartphone, the app (if already installed) will open and go directly to Luke chapter 15.

### 18.1. Setting up Deep Linking

To set up deep linking in your app:

1. Go to the **App ➔ Deep Linking** page within Scripture App Builder.
2. Select **Enable Deep Linking**.
3. Specify one or two link **schemes** to be associated with your app: a custom URI and/or a URL.

**Custom URI Scheme**

The first type of link scheme is a **custom URI** (Uniform Resource Identifier). This is a sequence of characters beginning with a letter and then any combination of letters, digits, plus (+), period (.), or hyphen (-). It is followed by a colon and two forward slashes (://).  

Here are some examples:
Make sure that you do not choose a custom URL already in use by a popular app, such as:

- fb:// Facebook
- twitter:// Twitter
- whatsapp:// WhatsApp
- youtube:// YouTube
- youversion:// YouVersion Bible App

**URL Scheme**
The second type of scheme is a **URL** (Uniform Resource Locator), which is like a web address. It begins with http:// or https://. It can include a path.

Here are some examples:

- https://mamara.org/
- https://mamara.org/bible/
- http://www.gospels-tanzania.org/
- https://wycliffe.org/mexico/huichol/bible/
- https://scriptureearth.org/mexico/hch/

### 18.2. Creating Deep Links
This section explains how you create deep links to content in the app. We will look at how to specify Bible references (books, chapters, verses), book collections, and how to turn the audio toolbar on when the app opens.

**Specifying Bible references in a deep link**
A reference is specified in the form **BBB.C.V**, where BBB is the book ID, C is the chapter number and V is an optional verse number.

Examples:

- LUK.15 Luke chapter 15
- JHN.3.16 John chapter 3 verse 16
- EPH.2.8 Ephesians chapter 2 verse 8

Please note that:

- The reference is case insensitive, so luk.15, Luk.15 and LUK.15 are all recognised as referring to Luke chapter 15.
The app will recognise OSIS book abbreviations as well as Paratext codes, such as Luke.15, 1Thess.3.5, 1Pet.2.

There are two ways of specifying the reference in a deep link:

**Method 1:** Append the reference immediately after the link scheme, e.g.

```
mamara-bible://JHN.3.16
https://mamara.org/bible/JHN.3.16
```

**Method 2:** Specify the reference in a query string, after ‘?’ and ‘ref=’, e.g.

```
mamara-bible://?ref=JHN.3.16
https://mamara.org/bible?ref=JHN.3.16
```

When someone taps on this link, the app (if installed) will open at the specified book, chapter and verse, using the currently selected layout and book collections.

**Specifying book collections in a deep link**

You can specify a book collection in the deep link, using a reference of the form DDD/BBB.C.V, where DDD is the book collection ID.

Here are some examples:

```
mamara-bible://MYK/JHN.3.16
https://mamara.org/bible/MYK/JHN.3.16
https://mamara.org/bible?ref=MYK/JHN.3.16
```

If you specify a book collection, the app will ensure that this book collection is being displayed:

- If the app is in single pane layout, the book collection will be changed to the specified collection if it is not there already.
- If the app is in two pane or verse-by-verse layout, and if the specified book collection is not among the two or three on the screen, the layout will be changed to single pane with the specified book collection.

**Turning on the audio toolbar in a deep link**

You can turn on the audio toolbar when the app launches, with the addition of the `audio=1` parameter in the query string of the deep link.

Here are some examples:

```
mamara-bible://JHN.3.16?audio=1
```
https://mamara.org/bible/MYK/JHN.3.16?audio=1

Note that a query string begins with the question mark (?) character before the first parameters, and then an ampersand (&) before subsequent parameters. So if you are using the ‘ref=’ method of specifying a reference, you will need to use ‘&’, e.g.

mamara-bible://?ref=JHN.3.16&audio=1
https://mamara.org/bible?ref=JHN.3.16&audio=1

18.3. Deferred Deep Linking
The deep links described above will only work if the user already has the app installed. If they do not have the app, when they tap on the link, their device will not recognise it and an error message will appear.

Branch (branch.io) provides a way of handling deferred deep links. If a user taps on a link to the app but does not have the app installed yet, the link will first redirect the user to the app store to download the app. Then after the app is installed and launched for the first time, the user will be taken to the deep link page.

Setting up the app to use Branch
To use Branch for deferred links:

1. Go to the Branch website, https://branch.io/ and Sign Up for an account if you do not already have one.
2. Create a new app in the Branch dashboard.
3. Go to the Link Settings page, find the Android section and click the checkbox ‘I have an Android App’.
4. Enter the custom URI scheme and where to download the app (e.g. on Google Play).
5. Within Scripture App Builder, go to the App ➤ Deep Linking page.
7. Enter the Branch Key for this app. This can be found on the Account Settings page in Branch and will be something like:

   key_live_abCdEF2GQ7ID9rLPxk91khczmpGZl71

8. Enter the Default Link Domain for this app. This can be found on the Link Settings page in Branch and will be something like:

   mamara-bible.app.link
**Creating deferred links**

Deep links using Branch will look something like this:

https://mamara-bible.app.link?ref=JHN.3.16

where mamara-bible.app.link is the **Default Link Domain** specified on the Branch **Link Settings** page.


---

**19. Analytics**

If you enable Analytics, the app will connect to the internet from time to time to send app usage information to one or more analytics accounts. This will give you an idea of the extent to which people are interacting with the app.

The information sent will include the model of the device (such as ‘Google Nexus 7’, ‘Samsung Galaxy S4’), the Android version (such as ‘4.2’), the mobile network provider and an approximate location (city/country). No personal information is included.

You can configure your app to send usage data to one or more of the following analytics engines:

<table>
<thead>
<tr>
<th>Analytics Engine</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Firebase Analytics</strong></td>
<td>Sends data to a Google Firebase Analytics account of your choice.</td>
</tr>
<tr>
<td><strong>Amplitude Analytics</strong></td>
<td>Sends data to an Amplitude account of your choice.</td>
</tr>
<tr>
<td><strong>Amazon Mobile Analytics</strong></td>
<td>Sends data to an Amazon Mobile Analytics account of your choice.</td>
</tr>
<tr>
<td><strong>S3 Digest Analytics</strong></td>
<td>Sends a digest of analytics data to an Amazon S3 Bucket of your choice.</td>
</tr>
<tr>
<td><strong>FCBH Digest Analytics</strong></td>
<td>Sends a digest of analytics data to Faith Comes By Hearing (FCBH).</td>
</tr>
<tr>
<td><strong>Google Analytics</strong></td>
<td>Sends data to a Google Analytics account of your choice. <strong>Note:</strong> Google Analytics is deprecated and will be removed in a future release.</td>
</tr>
</tbody>
</table>

To set up analytics:

1. Go to the **Analytics** page for the app.
2. Select Enable Analytics.

3. Click Add Analytics Account...

4. Choose an account type and enter your analytics account information.
   - For Firebase Analytics, you will need a google-services.json configuration file for your account.
   - For Amplitude Analytics, you will need an API Key.
   - For Amazon Mobile Analytics, you will need an App ID and an Identity Pool ID.
   - For S3 Digest Analytics, you will need an S3 Bucket ID and an Identity Pool ID.
   - For FCBH Analytics, you do not need any additional ID information.
   - For Google Analytics, you will need a Tracking ID.

19.1. Firebase Analytics

To sign up for Firebase Analytics, ensure you have a Google account.

You will need to:

1. Go to the Google Firebase website at https://firebase.google.com/ and ensure you are signed in with your Google account.

2. Click Add project to create a Firebase project for this app.

3. In Step 1, you will need to give your new project a Project name.

4. In Step 2, titled Google Analytics for your Firebase project, select Set up Google Analytics for my project and press Continue.

5. In Step 3, titled Configure Google Analytics, click on the drop-down box and choose Create a new account. Give it a name, which can be the same as your Firebase project name.

6. Check the boxes to confirm that you accept the analytics and data protection terms. Click Create project and wait a few seconds for the project to be created.

7. Click the Settings button (a cog wheel icon near the top) and select Project settings.

8. On the General tab of the Settings, scroll down to the My apps section and click the Android app app icon.
9. On the Add Firebase to your Android app page, enter your app package name and click Register app.

10. Download the config file, google-services.json. That is all you need from the app registration. You can ignore the information on the rest of the screens and return to Settings.

11. Go to the App > Firebase page in Scripture App Builder.

12. Select Firebase Analytics as one of the features to use in the app.

13. At the bottom of the page, click the Browse button and find the google-services.json config file that you have just downloaded from the Firebase console.

19.2. Amplitude Analytics
To use Amplitude analytics, you will need to create an account. Go to:

https://amplitude.com

You will need to:

1. Click Sign Up at the top right of the screen and create an account. You will receive an email to finish activating your account. Copy the link to your browser and go to the page and complete the activation process.

2. You will be prompted to create a new organization. You can do that to invite team members to join your organization and access the data. You will also be prompted for some additional information.

3. Click Create Project, enter the project name and click Create. There will be a project for each individual app.

4. Click Projects on the left of the screen. This will show the list of projects and the properties including a long string of hexadecimal characters under the label API Key.

5. Highlight and copy this string into the API Key field in Scripture App Builder.

19.3. Amazon Mobile Analytics
Amazon Mobile Analytics is part of the Amazon Pinpoint service. To use it, ensure you have admin permissions to an Amazon AWS account, and go to:

https://aws.amazon.com/console/

You will need to:

1. Click Sign In to the Console at the top right of the screen.

2. Go to Pinpoint Service (which includes Mobile Analytics)

3. Click Start your first project, enter a project name, check Allow AWS Mobile Hub to administer resources on my behalf, and click Create project.
4. Analytics are enabled by default. Click on the project name at the top left to view the dashboard.

5. Click Add new app, click Android, and click Add.

6. Click Download Cloud Config. Open the downloaded awsconfiguration.json file. Copy the AppId value inside the quotes into the App ID field in Scripture App Builder. Copy the PoolId value inside the quotes into the Identity Pool ID field in Scripture App Builder.

19.4. **Google Analytics**

To sign up for Google Analytics, ensure you have a Google account, and go to:

[https://analytics.google.com](https://analytics.google.com)

You will need to:

1. Create an analytics account
2. Click Admin in the menu on the left of the screen.
3. In the Property column, select Create a new property from the dropdown menu.
4. Select Website (rather than Mobile app, since Mobile app is now reserved for Firebase which is a different analytics engine).
5. Provide a Website Name. You can use the name of your app.
6. Provide a Website URL. You can use a website related to the app, such as where your app is advertised.
7. Click Get Tracking ID.

You will be given a tracking id, of the form UA-1234567-1 which you should copy into the Tracking ID field in Scripture App Builder.

19.5. **FCBH Digest Analytics**

Faith Comes By Hearing (FCBH) has established an analytics service for use with Scripture App Builder. By selecting FCBH Digest Analytics as the Account Type, your app will send a small daily digest (about 300 bytes for each day the app is used) of compressed, completely anonymous data (no personal, phone, or GPS location information) via an encrypted transport (https) to an Amazon data center in Asia, when the device is connected to the Internet (via cell or WIFI) while the app is running.

FCBH uses the resulting data for two purposes: 1) They make semi-annual contributions to text-holder organizations, proportional to the usage of corresponding audio recordings, and 2) They show usage data to visitors and donors to encourage and inspire involvement. Access to this service (data and dashboards) is available to interested partners (e.g. app builders) so they can easily track usage. Send an email to sab-analytics@fcbhmail.org to request access.
Data is aggregated by an FCBH server and analyzed using Splunk. A snapshot of one dashboard is below. The dashboard is interactive and allows drill-down to specific apps or versions or countries. The dashboard is a work in progress and interested ministry partners are welcome to contribute or build their own dashboards on the Splunk server.

While no location information is uploaded, Amazon’s servers record the IP addresses where data uploads occur from. FCBH then uses Maxmind’s free database to estimate device locations (at approximately 99% and 95% accuracy for country and city respectively).

19.6. S3 Digest Analytics

S3 Digest Analytics uses the same mechanism as FCBH Digest Analytics to report a small digest of analytics data. However, you are responsible for hosting the Amazon S3 Bucket and processing the received data. Files are uploaded to the S3 Bucket and in a sub-folder based on the format (e.g. the current format is f1) and stored with a unique filename using a randomly generated GUID as the basename. We are working with FCBH to package a Splunk configuration so that you can deploy your own server to analyze the data.

To use S3 Digest Analytics, ensure you have admin permissions to an Amazon AWS account, and go to:

https://aws.amazon.com/console/

You will need to:

1. Click Sign In to the Console at the top right of the screen.
2. Create an S3 Bucket.
a. Go to the S3 Service and click Create bucket, enter a Bucket name, select a Region near where the app will be distributed, and click Next.

b. On the Set properties and Set permissions steps, use the defaults and click Next.

c. Review the configuration and click Create bucket.

d. Copy the Bucket name into the S3 Bucket ID field in Scripture App Builder.

3. Create a Federated Identity.

   a. Go to the Cognito Service and click Manage Federated Identities. The first time you use this service it will start creating an identity pool for you. If the AWS account already has identity pools, then it will show a grid of existing one. If this is the case then click Create new identity pool.

   b. Enter an Identity pool name, click Enable access to unauthenticated identities (which allows users of the app to submit analytics without logging into some service), and click Create.

   c. Click Show Details to see the Role Name for the unauthenticated identities (in the next step, we will give them permission to put objects in the bucket created in the previous step). Click Allow.

   d. Copy the Identity pool ID value inside the quotes in the Get AWS Credentials section of the Sample code page shown after completion of the previous step. Copy this string into the Identity Pool ID field in Scripture App Builder.

4. Give permission to put data into the S3 Bucket.

   a. Go to the IAM Service and click Roles category.

   b. Click on the Role created in step #3 (e.g. Cognito_<IdentityPoolName>Unauth_Role).

   c. Click Add inline policy, click Service and choose S3.

   d. Click Actions, type in PutObject to search for actions, and check PutObject to select that action.

   e. Click Resources, use default Specific, click on Add ARN link, enter the Bucket name from step #1 into the Bucket name field, click the Any checkbox at the end of the Object name field, and click Add.

   f. Click Review policy, enter a name in the Name field, and click Create policy.

19.7. Data Payload for FCBH and S3 Digest Analytics

Both FCBH Digest Analytics and S3 Digest Analytics use the same JSON payload format. A complete sample data payload is below:
The payload is 296 bytes uncompressed and 224 bytes compressed. This sample is comprised of the following fields:

- One day of activity (1440 minutes), starting on 2018-03-06.
- The id is a GUID which was randomly generated on the phone when the app was first launched, enabling determination of how many unique installations of the app are in use (but no user-identifying information).
- Package and version indicate which app is in use.
- This report was for a single 21-minute session. This (and other) values would be incremented if the app had been used multiple times within the reporting period.
- The user pressed Share in the app 3 times.
- The app played FCBH audio HNDWTCN2DA, which is a “DAMid” from FCBH’s Digital Bible Platform (DBP).
- The app played audio for 25 minutes. Since this is greater than 21 minute session time, the audio must have been playing while the screen was off for 4 minutes. Comparison of these fields enable some rough comparison of audio-only use, versus use of audio in combination with text.
- Mark 1-4 were played. Mark 1 and 4 being listed twice each indicates that the user pressed play twice in each chapter (and thus, also pressed stop in each).
20. Registration Screen

You can define a registration screen to be shown when a user launches the app for the first time. This allows you to collect contact information, for example to connect people with Bible reading/listening discussion groups.

To set up a registration screen, you need to do some configuration work in two places:

- within Scripture App Builder, and
- in the Google Firebase console.

20.1. Setting up the Registration Screen in Scripture App Builder

To set up the registration screen within the app builder:

2. Select Require each user to register with their details when they first use the app.
3. Click the Configure Registration button.
4. Follow the instructions in each of the tabs in the Configure Registration dialog to specify the title, text, input fields and image to include on the registration screen. Use the Test buttons to preview the screens in a browser.
5. Click OK when you are finished in the dialog.
20.2. Setting up the database in the Google Firebase console

To set up the database, which will contain the registered users’ information, you need to add Firebase to your app, create a database, set up authentification and configure rules.

Add Firebase to your app

To add Firebase to your app:

1. Go to the Google Firebase website at https://firebase.google.com/ and ensure you are signed in with your Google account.
2. Create a Firebase project if you do not already have one for this app.
3. Click the Settings button (a cog wheel icon near the top) and select Project settings.
4. On the General tab of the Settings, scroll down to the My apps section and click the Android app icon.
5. On the Add Firebase to your Android app page, enter your app package name and click Register app.
6. Download the config file, google-services.json. That is all you need from the app registration. You can ignore the information on the rest of the screens and return to Settings.
7. Go to the App > Firebase page in Scripture App Builder.
8. Select Firebase Realtime Database as one of the features to use in the app.
9. At the bottom of the page, click the Browse button and find the google-services.json config file that you have just downloaded from the Firebase console.

Create a Database

To create a Realtime database:

1. In your Firebase project console, select Database from the menu on the left of the screen.
2. Scroll down the screen for the section titled Or choose Realtime Database and click the Create database button.
3. Choose Start in locked mode as the Security rules and click Enable.
**Set up Authentification**

On the Authentification page of the Firebase console, enable two authentification types on the Sign-in method tab:

1. **Email/Password** (this is used when viewing registered users in a web browser)
2. **Anonymous** (this is used during user registration in the app)

**Configure Rules**

On the Database page of the Firebase console, you need to enter rules on the Rules tab. These tell the database who will have access rights to read and write to the database.

Here is an example of a rule that you should **NOT** use:

```
{
  "rules": {
    ".read": true,
    ".write": true
  }
}
```

This rule gives everyone access to read and write to the database without any authentification. It is not the way to protect your data, so please do not use this one!

The following rule is much better. It gives write access only to the user who is making the registration. No one will have read access (except for you when you view the database from the Firebase console). Make sure you copy it exactly.

```
{
  "rules": {
    "users": {
      "$uid": {
        ".read": false,
        ".write": "$uid === auth.uid"
      }
    }
  }
}
```

The rule below is a modification of the rule above. If you want to give an administrator read access to the data, to be displayed in a web browser (See Configure Registration ➤ User Details ➤ View Data), here is the rule to use:

```
{
  "rules": {
    "users": {
      "$uid": {
        ".read": false,
        ".write": "$uid === auth.uid"
      }
    }
  }
}
```
(where me@abcd.com is a user added on the Authentication page)

21. EPUB

As well as building a smartphone app, you can create e-books in EPUB format. EPUB documents are readable by a number of e-book readers on Windows, Mac, iOS and Android platforms.

If you have timing files for your audio, the e-books can contain ‘Read Aloud’ text-audio synchronization. These are readable by a few EPUB 3 readers, such as the Readium extension for Chrome (http://readium.org) and the Gitden Reader apps for Android and iOS (http://gitden.com).

To create an EPUB e-book:

1. Choose whether to create a single e-book containing all the books or whether you want to create a separate e-book for each book. The latter is the best option if you will have audio in the book, since otherwise a whole NT with audio would be a very large e-book.

2. Choose a cover design. See the Cover tab. If you are creating separate e-books for each book, a different cover image can be specified for each book on the Cover tab of each individual Book page.

3. Click the button Create EPUB Document(s).

   The generated EPUB documents will be saved in the default EPUB output folder. See Tools ➔ Settings... ➔ Default Folders.

4. Open the EPUB documents in your chosen e-book reader.

Scripture App Builder generates EPUB 3 documents which should be backwardly compatible to be able to be read using EPUB 2 readers. EPUB 3-only features such as the text-audio synchronization will only be seen on compatible readers.
Viewing an EPUB Read Aloud document in the Gitden Reader app

Viewing an EPUB Read Aloud document in the Readium Chrome extension
22. Publishing and Distribution

Before you distribute your app, please use the *App Publishing Checklist* (available via the Help menu in SAB or on the SAB website) to verify that it is ready to publish.

Apps built with Scripture App Builder can be published on the Google Play store, distributed by memory card, shared by Bluetooth or Wi-Fi transfer, uploaded to websites, or sent out by email. For more information, please see the user manual *Distributing Apps* (available via the Help menu in SAB or on the SAB website).